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Ensayo 
 

Uso del software libre ImageJ para el estudio de larvas de 

dípteros de interés forense 

Iris Catherine Carma Arreaza,  Francisco Delascio-Chitty  y  José Gregorio González (†)  

Resumen.	 Se	 realizaron	 ensayos	 con	 el	 objetivo	 de	 determinar	 la	 utilidad	 del	 software	 libre	

“ImageJ”	(procesador	de	imágenes)	para	el	estudio	de	dı́pteros	de	interés	forense.	Se	empleó	una	

muestra	de	20	larvas	de	dı́pteros	de	la	familia	Calliphoridae,	género	Cochliomyia.	ImageJ	resultó	

ser	una	herramienta	 útil	para	el	estudio	de	estas	 larvas,	ya	que	se	obtienen	valores	con(iables	

similares	a	 los	del	 tradicional	vernier.	Se	hallaron	otras	ventajas	comparativas	como	el	estudio	

de	las	dimensiones,	áreas	o	volúmenes	de	los	huevos,	larvas,	pupas	y	cualquier	parte	del	insecto	

adulto,	ası́	como	determinación	de	colores,	conteo	de	individuos	y	realización	de		(ijaciones	foto-

grá(icas.	 Resaltando	 que	 todas	 estas	 observaciones	 pueden	 ser	 registradas	 y	 reproducidas	 la	

cantidad	de	veces	que	se	requiera,	potenciando	y	consolidando	cualquier	hallazgo	cientı́(ico,	 lo	

cual	es	de	gran	interés	en	el	campo	forense,	ya	que	las	experticias	que	se	originan	son	objetivas,	

reproducibles	y	de	gran	valor	en	tribunales	competentes.		

Palabras	clave:	ImageJ;	Entomologı́a	Forense;	Dı́pteros;	larva	de	mosca		

Use	of	ImageJ	free	software	to	study	Diptera	larvae	of	Forensic	importance	

Abstract.	 Tests	 were	 carried	 out	 in	 order	 to	 determine	 the	 usefulness	 of	 the	 free	 software	

“ImageJ”	(image	processor)	to	study	diptera	of	forensic	interest.	A	sample	of	20	diptera	larvae	of	

the	Calliphoridae	family,	genus	Cochliomyia,	was	used.	ImageJ	becomes	a	useful	tool	for	the	study	

of	these	larvae,	because	produce	reliable	values	similar	to	those	of	the	traditional	caliper.	A	number	

of	other	comparative	advantages	such	as		 the	study	of	 the	dimensions,	areas	or	volumes	of	the	

eggs,	larvae,	pupae	and	any	part	of	the	adult	insect,	as	well	as	determining	colors,	enumerating	

individuals	and	making	photographic	 (ixations	were	found.	Highlighting	that	all	 these	observa-

tions	can	be	recorded	and	reproduced	as	many	times	as	required,	enhancing	and	consolidating	

any	scienti(ic	(inding,	which	is	of	great	interest	in	the	forensic	(ield,	since	the	expertise	that	origi-

nates	is	objective,	reproducible	and	of	great	value	in	competent	courts.		

Key	Words:	ImageJ,	Forensic	Entomology,	Diptera;	(ly	larvae	

Introducción	

La	identificación	de	insectos	y	el	estudio	de	su	ciclo	de	vida	pueden	ser	de	

utilidad	en	la	investigación	penal,	para	estimar	el	tiempo	transcurrido	desde	que	

un	individuo	murió	o	el	“intervalo	post-mortem	(IPM)”	(Rueden	et		al.	2017).	Para	

evaluar	el	IPM,	se	consideran	tres	métodos:	1)	el	uso	de	curvas	de	crecimiento;	

2)	la	matriz	de	ocurrencia	de	las	especies	presentes	en	el	cuerpo	humano	sin	vida	

y	3)	recientemente	la	tendencia	a	nivel	internacional	de	usar	el	método	llamado	

“horas	grados	acumulados	(HGA)”	(Núñez	2016).	

Los	insectos,	y	sus	estructuras,	tales	como	patas,	antenas,	alas,	entre	otras,	

se	examinan	con	la	ayuda	de	equipos	ópticos	de	amplificación,	en	este	sentido,	
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el	microscopio	estereoscópico	y	la	fotografıá	digital	son	de	gran	ayuda	para	capturar	

y	 compartir	 estas	 observaciones,	 plasmándolas	 en	 una	 imagen	 que	 puede	 ser	

reproducida	 las	 veces	 que	 se	 requiera,	 potenciando	 y	 consolidando	 de	manera	

pragmática	cualquier	hallazgo	cientıf́ico.	Aunque	en	la	actualidad	se	han	producido	

grandes	 avances	 en	 los	métodos	moleculares	 de	 identificación	 de	 especies,	 el	

estudio	de	la	morfologıá	de	los	insectos	aún	sigue	siendo	la	técnica	más	accesible,	

rápida	y	económica	para	los	laboratorios	de	Entomologı́a	Forense	(EF).		

Las	mediciones	 en	 los	 insectos	 son	 importantes	 en	 la	 EF,	 debido	 a	 que	 se	

utilizan	como	indicadores	de	la	etapa	del	desarrollo,	y	del	tiempo	que	transcurre	

desde	 la	 colonización.	Hoy	 en	dı́a	 con	 la	disponibilidad	de	 cámaras	digitales	de	

alta	resolución,	es	técnicamente	posible	medir	la	muestra	con	una	mı́nima	mani-

pulación.	Esto	es	útil	por	ejemplo,	para	diferenciar	entre	las	larvas	que	todavı́a	se	

están	alimentando	del	cuerpo	en	descomposición	y	las	que	se	están	alejando	de	la	

fuente	de	alimentación	para	pupar,	la	medición	de	la	longitud	del	tracto	digestivo	

permite	discernir	entre	ambas	fases	(González	et	al.	2011).	

Los	métodos	usuales	para	medir	la	longitud	de	las	larvas	de	insectos	pueden	

provocar	que	se	obtengan	variaciones	según	la	técnica	de	preservación.	Para	evitar	

esto,	 algunos	 autores	han	propuesto	medir	 los	 insectos	 en	vivo.	 Al	 respecto	

Villet	(2007)	informó	sobre	una	técnica	utilizando	el	micrómetro,	pero	esta	técnica	

es	limitada,	ya	que	el	movimiento	de	los	insectos	di,iculta	la	medición,	por	altera-

ción	de	la	longitud	corporal.	Publicaciones	recientes	han	empleado	imágenes	digi-

tales	 para	medir	 la	 longitud	 de	 los	 insectos,	 usando	 como	 complemento	 herra-

mientas	de	software,	comerciales	y	de	código	abierto	requiriendo	de	programas	

especı,́icos,	tales	como	ImageJ	(Bourne	et	al.	2019).	

ImageJ	es	un	programa	que	está	en	continuo	desarrollo	desde	el	año	1997,	fue	

diseñado	para	el	procesamiento	de	imágenes	cientı́,icas	por	Wayne	Rasband,	en	

el	“National	Institute	of	Health	(NIH)”	(Schneider	et	al.	2012).	ImageJ	se	descarga	

gratuitamente	desde	el	sitio	web:	https://imagej.nih.gov/ij	y	su	código	fuente	es	

de	dominio	público,	por	lo	que	no	está	sujeto	a	derechos	de	autor,	promoviéndose	

su	distribución	y	modi,icación,	con	solo	citar	la	fuente	(Rasband		2016).	Al	estar	

construido	con	Java	(de	allı́	el	uso	de	la	“J”),	funciona	en	cualquier	sistema	opera-

tivo:	Linux,	Mac	OS	X	y	Windows.	En	la	actualidad,	ImageJ	puede	ejecutarse	en	un	

applet	 en	 lı́nea,	 como	 aplicación	 ejecutable	 en	 teléfonos	 inteligentes,	 tablets	 o	

cualquier	computadora.	El	software	ImageJ	puede	mostrar,	editar,	analizar,	proce-

sar,	guardar	e	imprimir	imágenes	digitales	de	8	bits	(256	colores),	16	bits	(miles	

de	colores)	y	32	bits	(millones	de	colores).	Puede	leer	varios	formatos	de	imagen	

(TIFF,	PNG,	JPEG,	BMP,	FITS).		

Este	 ensayo	 tiene	 por	 finalidad,	 mejorar	 las	 mediciones	 realizadas	 en	 los	

dı́pteros	de	 interés	 forense	y	determinar	 la	utilidad	del	software	 libre	“ImageJ”.	

Con	 lo	cual	se	pretende	 fortalecer	 la	EF	como	una	herramienta	auxiliar	en	el	

SENAMECF,	mediante	la	elaboración	de	un	listado	de	las	ventajas	y	posibles	limi-

taciones	que	aporta	esta	herramienta	en	la	investigación	penal	y	la	divulgación	de	

los	resultados	aquı́	descritos.	
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Materiales	y	métodos	

Este	estudio	se	realizó	el	mes	de	agosto	del	año	2021,	en	el	Laboratorio	de	la	

Dirección	 de	 Análisis	 Biológico	 y	 Genética	 Forense	 del	 SENAMECF,	 sede	 Bello	

Monte,	Caracas,	Venezuela.	

Los	datos	meteorológicos	de	temperatura	y	humedad	relativa	fueron	obtenidos	

por	la	estación	climatológica	del	Instituto	Nacional	de	Meteorologı́a	e	Hidrologı́a	

(INAMEH)	instalada	en	el	SENAMECF	sede	Bello	Monte,	los	datos	fueron	registrados	

con	la	ayuda	del	software	de	X-tem,	ver	1.0.01	desarrollado	por	Sutron	Corp.	

Se	utilizó	como	bio-modelo	larvas	de	dıṕteros	pertenecientes	al	género	Cochliomyia	

(Figura	1),	colectadas	en	un	cadáver,	caso	de	estudio	en	la	sala	de	autopsias	del	

SENAMECF,	sede	Bello	Monte.		

La	 determinación	 del	 taxón	 se	 realizó	 mediante	 el	 estudio	 de	 las	 larvas	 y	

ejemplares	 adultos	 en	 el	 laboratorio	 entomológico	 de	 la	 Fundación	 La	 Salle	 de	

Ciencias	Naturales	EDIAGRO	Cojedes,	mediante	la	observación	de	caracteres,	con	

la	ayuda	de	una	lupa	estereoscópica	y	el	uso	de	claves	taxonómicas.	Los	especı-́

menes	fueron	depositados	en	el	archivo	del	laboratorio	de	la	Coordinación	de	EF	

del	SENAMECF,	como	material	indubitado	para	futuras	comparaciones.		

La	 colecta	 de	 insectos	 fue	 realizada	 siguiendo	 las	 recomendaciones	 de	 la	

Asociación	Europea	de	EF	(Amendt	et	al.	2006).	Un	total	de	cuarenta	(40)	larvas	

fueron	sacri,icadas	en	agua	caliente	y	preservadas	en	etanol	al	70%,	el	resto	se	

incubó	 hasta	 la	 fase	 adulta	 para	 su	 identi,icación.	 Posteriormente,	 un	 total	 de	

veinte	(20)	 larvas	se	midieron	con	la	ayuda	de	un	vernier	y	el	software	ImageJ.	

Las	 imágenes	 se	 obtuvieron	 con	 un	microscopio	 estereoscópico	marca	 Leica,	

modelo	WILD	M-3B	y	una	cámara	digital	Nikon	Coolpix	950,	en	el	Museo	de	Historia	

Natural	de	la	Fundación	La	Salle	de	Ciencias	Naturales,	Caracas.	En	cada	imagen		

se	empleó	una	escala	patrón	de	1	cm	de	ancho,	con	graduaciones	de	0,1	mm.	Se	

obtuvo	las	medidas	de	largo	y	ancho	de	los	especı́menes.	Durante	cada	medición	

se	observaron	los	espiráculos	posteriores,	estructuras	que	sirven	para	identificar	las	

especies	y	las	fases	larvarias	(Figura	2).			

Figura 2. Espiráculos posteriores de una larva de 

Cochliomyia. 

Figura 1. Individuo adulto del género de dípteros 

Cochliomyia. Escala total 1 cm, dividida en 10 mm.  
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La	media	y	desviación	estándar	fueron	calculadas	con	la	ayuda	de	una	hoja	de	

cálculo	Excel©.	También	se	utilizó	el	software	libre	ImageJ	para	obtener	el	valor	

de	las	medidas	de	longitud	de	las	larvas,	cálculos	de	media	y	desviación	estándar.	

Se	 realizó	 la	 comparación	 de	 varianzas	 entre	 las	dos	muestras,	 utilizando	el	

test	 F,	 donde:	 ec.	1	

	

Para	el	uso	de	ImageJ	el	software	cuenta	con	una	barra	de	herramientas,	que	
se	 despliega	 como	una	 pequeña	 ventana	 en	 el	 escritorio	 de	 la	 computadora.	 La	
misma	posee	tres	secciones:	1)	el	menú	que	contiene	accesos	como	File,	Edit,	Image,	
Window,	etc.;	2)	los	botones	de	herramientas	que	permiten	elegir	la	herramienta	
de	trabajo,	p.	ej.	selección	de	área	rectangular,	oval,	puntos,	zoom,	etc.	y	3)	la	barra	
de	información.	

Para	abrir	la	imagen,	desde	la	opción	File>Open	del	menú	principal	se	selecciona	
la	 imagen	que	se	requiere	examinar	en	cualquier	 formato	o	archivo	de	 imagen,	 los	
más	frecuentemente	usados	son	JPEG	y	TIFF	(Ferreira	y	Rasband	2012).	

El	 proceso	de	calibración	 espacial	 implica	 asociar	 los	pı́xeles	de	una	 imagen	
con	un	valor	conocido	en	mm,	cm,	µm	etc.	Siempre	se	necesita	una	referencia,	por	
ejemplo,	una	regla	visible	en	la	imagen.	Con	la	herramienta	selección	de	lı́nea,	
se	traza	una	recta	a	lo	largo	de	escala	de	referencia	(,lecha	amarilla	en	las	,iguras	
3	y	4).	Para	ser	lo	más	preciso	posible	se	puede	usar	Zoom		

En	la	barra	de	menú	en	la	función	Analyze>Set	scale,	se	introduce	la	dimen-
sión	real	de	la	lıńea	dibujada	en	la	caja	de	distancia	conocida	(Known	distance)	y	se	
establece	la	unidad	en	la	caja	unidad	de	longitud	(Unit	of	length).	En	el	ejemplo	la	
lı́nea	se	dibujó	sobre	la	medida	de	1	mm	(Fig.	4).	Para	colocar	la	barra	de	escala	en	
la	foto	se	hace	desde	el	menú	Analize>Tools>Scale	Bar,	allı́	se	elige	el	tamaño	de	
la	barra,	también	su	posición,	color,	y	tipo	de	letra	entre	otros	(Figura	5).	Se	debe	
tomar	en	cuenta	calibrar	la	imagen	cada	vez	que	se	utilicen	imágenes	que	se	obtu-
vieron	con	un	diferente	aumento	(zoom)	en	la	fotografı́a	original.	

Una	 vez	 calibrada	 la	 herramienta	 se	 puede	 realizar	 cualquier	 medición,	 ya	
sean	lı́neas	o	áreas.	Primero	se	selecciona	lo	que	desea	medir	trazando	una	lıńea	o	
dibujando	un	área,	y	desde	el	menú	Analize>Measure	o	presionando	la	letra	“m”	
del	 teclado	 se	 despliega	 una	 nueva	 ventana	 de	Results	 que	muestra	 el	 valor	
ponderado.	Esto	genera	una	tabla	de	Excel	que	se	puede	guardar	para	futuros	
trabajos,	 usando	 File>Save.	 Además	 de	 medir	 lı́neas	 rectas,	 también	 se	 puede	
usar	lı́nea	a	mano	alzada	o	lı́neas	segmentadas	(Figura	6).		

Para	 añadir	 texto,	 se	 selecciona	 en	 el	menú	 principal	 las	 opciones	 de	 herra-
mienta	de	Texto	y	Fuente	y	Tamaño.	Se	 indica	 la	 zona	donde	se	 insertará	con	
un	 rectángulo	 ⇒	 escribir	 ⇒	 ctrl+b	 (overlay)	 ó	 ctrl+d	 (estampar).	
Edit>Options>Colors>Foreground,	selecciona	el	color.	Para	añadir	,lechas,	en	el	
menú	principal	está	la	opcion:	Line	Tool>right	click	>Arrow	Tool,	y	doble	clic	en	
la	herramienta	para	con,igurar	los	parámetros	de	la	,lecha.	

Para	realizar	un	conteo	se	abre	un	archivo	de	imagen	y	se	selecciona	la	herra-
mienta	Point	tool,	al	hacer	click	en	la	herramienta	contar,	en	la	ventana	emergente	se	
elige	el	tipo	de	marca	(punto,	cıŕculo	o	cruz),	color	y	tamaño.	En	la	ventana	queda	
registrado	la	cantidad	de	elementos	contados,	señalados	con	un	cıŕculo	en	la	figura.	
Para	 borrar	 un	 punto,	 presionar	 ALT	 y	 hacer	 click	 sobre	 el	mismo;	 también	 se	
puede	mover	(Figura	7).	Cuando	se	pueden	separar	los	objetos	de	interés	y	el	fondo,	

���� =
�2 	

�2 

=  

2,22

1,23
= 1,80 
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Figura 4. Función Analize>Set scale, para asignar los 
valores de medida a los pixeles.  

Figura 3. Dibujo de una línea sobre la escala de 
referencia para calibrar la imagen. Larva de 
Cochliomyia 

Figura 5. Barra de escala, para tener una referencia 
del tamaño de los objetos en la imagen.  

Figura 6. Medición realizada en una larva de 
Cochliomyia con la herramienta línea a mano 
alzada, del Software ImageJ.  

Figura 7.- Herramienta contar, aplicada la 
enumeración de larvas de Cochliomyia. 
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el	contador	automático	con	ImageJ	es	rápido	y	puede	eliminar	tediosos	procesos	
de	conteo	manual.	La	herramienta	contador	de	ImageJ	ayuda	a	etiquetar	los	obje-
tos	y	elimina	el	problema	de	"perder	la	pista"	durante	el	proceso	de	enumeración
(Pride	y	Agehara	2021).	

	

Resultados	y	discusión	

Durante	 este	 ensayo,	 en	 los	 alrededores	 del	 Laboratorio	 de	 la	 Dirección	 de	

Análisis	Biológico	y	Genética	Forense	del	SENAMECF,	sede	Bello	Monte,	se	registró	

una	temperatura	promedio	de	25,94	°C	y	humedad	relativa	promedio	de	76,09%.	

	En	la	tabla	1	se	muestra	el	promedio	y	la	desviación	estándar	de	la	longitud	de	

las	 larvas	obtenida	mediante	el	uso	del	vernier	y	el	 software	 ImageJ.	Además	 se	

indican	las	ventajas	y	limitaciones	de	ambos	métodos	para	el	estudio	de	dı́pteros	

de	interés	forense,	y	se	exponen	los	motivos	más	relevantes	para	recomendar	el	

uso	del	software	ImageJ.	Sin	embargo,	uno	de	los	más	importantes	para	los	forenses	

es	 que	 con	 esta	 herramienta,	 se	 pueden	 convertir	 las	 imágenes	 a	 valores	

numéricos	objetivos	 registrados	 en	 tablas	 generadas	por	 el	 software	 (Figura	6),	

estadıśticamente	 relevantes	 y	 reproducibles,	 elemento	 importante	 para	 presentar	

los	resultados	en	juicio.	

Durante	la	medición	de	las	larvas	con	el	empleo	del	vernier,	no	se	consideran	

las	distancias	formadas	por	las	curvaturas	producto	de	los	movimientos	durante	

el	 desplazamiento	 de	 las	 larvas,	 con	 el	 uso	 de	 la	 herramienta	mano	 alzada	 del	

software	ImageJ,	se	obtiene	una	medición	más	exacta	de	la	longitud	corporal	de	la	

larva	(Villet	2007).		

El	software	 ImageJ	 fue	preciso,	arrojando	un	valor	más	bajo	de	desviación	

estándar	comparado	con	el	tradicional	vernier.	Sin	embargo,	al	aplicar	el	test	F,	el	

valor	del	Fexp	(ec.1)	es	menor	que	F	(α=	0,05;	n=	20,	20)=2,46;	por	lo	tanto,	con	el	

nivel	de	 signi,icancia	elegido,	 la	diferencia	en	 las	precisiones	no	es	 signi,icativa.	

Aunque	este	método	tiene	algunas	limitaciones,	 la	evaluación	de	los	insectos	utili-

zando	el	software	ImageJ	es	una	solución	rentable,	simple	y	de	fácil	acceso.	Reco-

mendable	 como	 un	 método	 alternativo	 para	 realizar	 diferentes	 mediciones	 en	

dı́pteros	de	interés	forense.		

En	conclusión,	el	procesador	de	imágenes	ImageJ	resultó	ser	una	herramienta	

útil	para	el	estudio	de	dıṕteros	de	interés	forense,	ya	que	con	él	se	pueden	obte-

ner	 datos	 confiables	 comparables	 con	 el	 tradicional	 vernier,	 para	 estudiar	 las	

dimensiones,	áreas	o	volúmenes	de	los	huevos,	larvas	y	cualquier	parte	del	insecto	

adulto,	realizar	las	fijaciones	fotográficas	y	lo	más	importante,	todas	estas	observa-

ciones	pueden	ser	registradas	y	reproducidas	las	veces	que	se	requiera,	potenciando	

y	consolidando	cualquier	hallazgo	cientıf́ico.	Lo	cual	es	de	gran	interés	en	el	campo	

forense	ya	que	 las	experticias	que	se	originan	son	objetivas,	 reproducibles	y	de	

gran	valor	en	los	tribunales.	

Las	 imágenes	 en	 sı́	mismas	 son	 excelentes	datos	 visuales.	 Las	 fotografı́as	 se	

pueden	guardar	 con	metadatos,	 como	geolocalización,	 fecha	y	hora	 automática-

mente.	
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Tabla 1. Datos sobre la media, desviación estándar, de las mediciones de longitud realizadas a 20 larvas 

de Cochliomyia. Ventajas y limitaciones en el uso del vernier y software ImageJ.  

N= número de muestras,   = media, (S)= Desviación estándar  X� 

 Vernier  ImageJ 

Número de muestra (N) 20 20 

Larvas Longitud X� 

(mm) 
11 11,14 

Desviación Estándar (S) 1,49 1,11 

Varianza S2 2,22 1,23 

Ventajas 

1) Se pueden realizar mediciones 

fuera del laboratorio (campo). 

2) No requiere de equipos de 

amplificación o fijación de 

imágenes. 

1) Software libre y gratuito. 

2) Valores numéricos e imágenes 

quedan registrados en tablas, 

puede ser ejecutado con 

cualquier sistema operativo, 

actualizaciones, ampliaciones, 

realiza operaciones geométricas, 

permite la edición, procesar 

colores, contar estructuras. 

3) Con el uso de la herramienta 

mano alzada del software 

ImageJ, se obtiene una medición 

más exacta de la longitud 

corporal de la larva.  

4) Se registran las cantidades de 

larvas con la ayuda de la 

herramienta contar. 

5) Puede ejecutarse en un applet en 

línea, como aplicación ejecutable 

en teléfonos inteligentes, tablets, 

laptos o en cualquier 

computadora. 

6) Las fotografías se pueden 

guardar con metadatos, como 

geolocalización, fecha y hora 

automáticamente. 

Limitaciones 

1) Equipo costoso, requiere 

recambio de baterías. 

2) Valores e imágenes no quedan 

registrados.  

3) Sólo aplica para medidas de 

longitud.  

1) Las mediciones deben realizarse 

en el laboratorio, equipos con 

conexión a internet o área 

equipada con lupas, cámaras y 

computadoras. 

2) La precisión de las mediciones 

puede verse afectada por la 

calidad de la imagen. 
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